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Introduction

What is SELV?

SELYV stands for Sistema Electrénico de Logistica de Vacinas. It is a data management
system designed specifically to help with tracking the process of vaccine distribution
and use in Mozambique. SELV is based on OpenLMIS, an open-source software
platform developed through a partnership of organizations working internationally to
address logistics challenges.

SELV is unique in that it is a web-based system that can also be used offline. It can be
accessed on any computer or tablet that has Firefox web browser installed.

SELV is replacing vrMIS, the system previously used to support field coordinator data
reporting.

What is SELV designed to do?

SELV was created to support Field Coordinators in their responsibilities of distributing,
tracking, and reporting vaccines. Each step in the distribution process is supported by a
different part of SELV.

As you (a Field Coordinator) prepare for your delivery, SELV provides information on
how many and what types of vaccines you will need to take on distribution. During your
distribution, SELV can be used on a tablet to immediately record information on facility
vaccine supply and status. After the distribution is complete, SELV provides a simple
way to enter data on a PC directly to the server without a need for the sending of paper
forms.
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Prepare G Record
for _>oon distribution
distribution distribution data
SELV | SELV | SELV | SELV |
v v v v
View Load Record Data Manage View Report
Amounts with tablet Distributions Workbook or PDF

Note that the tablet-based version of SELV will not initially be rolled out nation-wide.
Tablets will be tested and, if found to be useful, will be launched in all provinces.

How is SELV different from vrMIS?

The functionality of SELV and vrMIS are very similar, but there are some key

differences you need to know:

SELV

You will have your own user account

vrMIS

Shared user accounts

Graphical and Textual reports available in Tableau
workbook

Text Reports included in Website

Must enter “Visited” or “Not Visited” for EVERY
FACILITY when entering data for a delivery zone

Leave the facility blank when no data was
collected

To enter facility data, you must “initiate” a
distribution for a particular month and delivery
zone

Distributions automatically available for entering
data

Can’t view data after it has been synchronized

Able to view data you or others have entered after
it has been synchronized

Visit Info and Observations on a single tab

Separate visit info and Observations tabs

Can indicate data for an entire tab was Not
Recorded

Could only indicate N/R at the field level

Add the refrigerator to the system only once. For
all subsequent months, just enter the data about
the refrigerator’s temperature

Enter the refrigerator brand and data every month
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SELV Concepts

SELV Tasks

SELV was designed with several specific tasks in mind that directly support the work of
field coordinators. As mentioned earlier, SELV also allows users to perform some of

these important tasks while not connected to the Internet. See the table below for
descriptions of the main tasks possible in SELV, the concept behind each task process,
and in what modes (online or offline) the task can be completed.

Description Online Offline
Mode Mode
View Load Before going on a delivery, you will want to know how much of each v/ X
Amounts vaccine to take with you. View Load Amounts allows you to select the
specifics of the distribution and calculate EPI supplies needed.
Initiate a Initiating a distribution is the first step in the process of recording e X
Distribution data. It provides the correct facilities template for each distribution
zone. No data can be recorded for a distribution until it is initiated in
the system.
See Initiated Once a distribution has been initiated by any user on your computer, v/ v
Distributions you will be able to see it in the “Initiated Distributions” list.
Record Data Recording data is the main purpose of SELV. This is when you enter e v
all the information collected for each facility on a distribution.
Synchronize a Synchronizing a distribution means that all data entered for facilities v/ X
Distribution within an initiated distribution will be fully saved into the server.
Delete a Deleting a distribution is not a necessary step. It is meant to help e v
Distribution clear out completely synchronized distributions.
SELV User Manual — VillageReach, June 2014 4
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Accessing the SELV Website

Accessing the SELV website is the first step in using SELV. The site is accessible in
both online and offline mode:

Online mode:

If it is your first time ever logging into SELV, or if you need to start entering data for a
distribution, or sync data for a distribution, see Accessing SELV in Online Mode (page
5).

Offline mode:

If you would like to re-open SELV while offline to add data to a distribution you have
already started working on, see Accessing SELV in Offline Mode (page 8).

Accessing SELV in Online Mode

You will want to access the SELV website in online mode if you need to log in, initiate a
distribution, or synch a distribution.

Step-by-step guide

1. Make sure your computer is connected to the Internet.

2. Open Firefox web browser. Make sure your browser is not in private browsing
mode.

3. Go to http://selv.villagereach.org. You should arrive at the login page with the
large SELV icon.

Sistema Eletronico de Logistica de Vacinas portugués | Engiish

Entrar

lome de Usuario
Esqueceu sua senha?

4. In the upper right-hand corner, click on the language you prefer to view the
website in.

SELV User Manual — VillageReach, June 2014 5
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Enter your username and password and click Sign In.

You will now be at the SELV home landing page.

Bookmark this home page (not the login page) so that you have an easy way to
return to SELV if you close the browser. You can use this bookmark to get back
to SELV in both online and offline mode. See Tips and Tricks below for how to
bookmark the page.

From this page you can navigate to Distributions, change the language, or
logout.

o
E Sistema Eletronico de Logistica de Vacinas Logado como FildCoordinatorNiassa |
Sair

Casa Distribuigbes portugués | English

Continue to Initiating a Distribution to begin the reporting process.

Tips and Tricks:

Are you not seeing the login page? Check to make sure you have an active
Internet connection.

To bookmark the SELV homepage in Firefox:

1. Make sure you are on the SELV homepage.
(https://selv.villagereach.org/public/pages/index.html)

2. Click the star button in the top righthand toolbar to bookmark the page. ﬁ
It will turn blue once you click it.

3. To get to your bookmarked page, begin typing “selv” or “Open-LMIS” into the
URL bar. You will see several different options for URLs appear in the drop-
down. Click the one with the blue star next to it. This will take you to the
correct SELV page.

SELV User Manual — VillageReach, June 2014 6
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Login Credentials

Your login credentials have already been given to you by SELV administrators. Each
user has a unique username and password that they use to access the site. If you
forget your password, contact your VillageReach system administrator. If you click the
“Forgot Password?” link on the homepage and enter your username, a message will
automatically be sent to the system administrator letting them know you need help.

Your Username:

Your Password:
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Sistema Eletrénico de Logistica de Vacinas portugués | English

[‘3"6‘ de Usudrio

Esgueceu sua senha?

Accessing SELV in Offline Mode

You will want to access SELV in offline mode if you do not want to be connected to the
Internet but still wish to view or record data for initiated distributions. For more
information on what can be done in offline mode, see SELV Tasks (page 4).

Note: Accessing SELV in offline mode is only possible if you have not logged out since
logging in with your username and password. Closing the window and the browser will
not log you out, but clicking “Log out” will.

Step-by-step guide

1. Make sure you are not connected to the Internet.

2. Open Firefox web browser.

3. Inthe URL bar, begin typing "selv". Click on the URL with the blue star next to it.
(If you do not have the homepage bookmarked you need to type in the URL
https://selv.villagereach.org/public/pages/index.html)

4. Even though you are not connected to the Internet, the browser will bring up the
cached SELV homepage. You do not need to log in.

SELV User Manual — VillageReach, June 2014 8
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E Sistema Eletrdnico de Logistica de Vacinas

Casa Distribuigdes Go Online

5. Continue to Recording Distribution Data to begin inputting data for initiated
distributions while in offline mode. If you wish to switch to online mode, see Go
Into Online Mode (page 10).
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Understanding Online and Offline Mode
Online and Offline Functionalities

SELV allows you to complete certain tasks in online or offline mode. For more on which
tasks can be completed in which mode, see the previous SELV Tasks table in SELV
Tasks.

Switching Between Offline and Online Modes
Go Into Offline Mode

If you have already initiated the distribution, you may continue on to record data for that
distribution while in offline mode. For more information on tasks that can be completed
offline, see SELV Tasks.

Step-by-step guide

1. Disconnect your computer from the Internet.

2. Click Home.

3. You should now see the button Go Online (Conecte-se a Internet) in the upper
right-hand corner of the page (but do not click it). If you can see the button it
means you are now successfully working in offline mode.

Conecte-se a Internet

4. Continue to Recording Distribution Data to begin recording data while in offline
mode. To go back into online mode, see Go Into Online Mode (page 10).

Go Into Online Mode

Going into online mode is essential for key tasks within SELV, including initiating
distributions and synching distributions. This tutorial will describe how to switch from
offline to online mode. For more information on functionalities in online mode, see
Online and Offline Functionalities (page 10).

Step-by-step guide: Go Into Online Mode

1. Connect your computer to the Internet.
2. If you are already on a SELV page, click the Go Online button in the top right-
hand corner.

SELV User Manual — VillageReach, June 2014 10
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Conecte-se a Intemet

3. If you not already on a SELV page, follow the instructions on Accessing the
SELV Website (page 5).

4. Once you have successfully switched into online mode, you will see the language
and logout options in the top right-hand corner of the window instead of the Go
Online button.

Logado como FieldCoordinatorNiassa | Sair

portugués | English

You may now perform tasks that require you to be in online mode, such as Initiating a
Distribution (page 12).

Tips and Tricks:

If you click the Go Online button and you get the error message "Unable to connect to
the server," it means that your computer is not connected to the Internet.

Conecte-se a Internet

© N3o ¢ possivel conectar ao x
servidor

Try to reconnect your computer and then click the button again. If your computer is
successfully connected to the Internet and you still get the error message, please
contact the SELV admin.

SELV User Manual — VillageReach, June 2014 11
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Initiating Distributions

Initiating a distribution is a necessary step in entering reported data and can only be
done in online mode. Once a distribution has been initiated, you can enter data in either

online or offline mode.

Initiate a Distribution
Step-by-step guide

1. From the SELV home screen after login, click Distributions and select Manage.

o
E Sistema Eletronico de Logistica de Vacinas Logado como FieldCoordinatorNiassal

Sair
Casa Distribuigcdes portugués | English

Gerir

2. From the available dropdown menus, select the Delivery Zone, Program,
and Month for the distribution you would like to initiate.

SELV User Manual — VillageReach, June 2014 12
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[+ ]
E Sistema Eletronico de Logistica de Vacinas Logado como FieldCoordinatorNiassa |

Sair

Casa Distribuigdes portugués | English

Gerenciar uma Distribuigao

Zona de entrega

- Selecione a Zona de entrega - | ¥

Programa

- Né&o Atribuido -

«

Periodo

- Né&o Atribuido -

«

Ver valores de carga |  Iniciar Distribuigéo |

Distribui¢des iniciadas

Nao distribuigdes em cache

3. Once you have made your selections, click Initiate Distribution.
4. If initiating the distribution was successful, the distribution will appear in the
"Initiated Distributions" list at the bottom of the page.

Periodo

Margo-2013 v

Ver valores de carga Iniciar Distribuicao
Distribuigbes iniciadas
Zona de entrega Programa Periodo Estado

Norte Niassa Vacinas Margo-2013 INITIATED Registro de Dados Sincronize

5. The distribution has now been cached and will be available to the user for data
entry in both online and offline mode.

6. (Optional) If you wish to continue on in offline mode, see Go Into Offline Mode
(page 10).

7. Continue to Recording Distribution Data (page 15) for instructions on entering
data for your initiated distributions.
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Tips and Tricks:

* In Step 2 above you are asked to select the month, which is the month of the
distribution. The distribution month is the month during which you started the
distribution, even if it was at the very end or very beginning of the month. For
example, if you left on August 31%, it is an August distribution. If you left on
September 1%, it is a September distribution.

* All distributions that have been successfully initiated on your computer will be
visible in the "Initiated Distributions" list at the bottom of the page in Step 4, even
if they were initiated by a different user. Make sure that the distribution with the
zone, program, and month you have specified shows up as well, otherwise you
will not be able to enter data for that distribution when in offline mode.

* If you click Initiate Distribution and the distribution does not show up in your list,
reselect the zone, program, and month and try again. If it still does not work,
contact the SELV admin.

SELV User Manual — VillageReach, June 2014 14
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Recording Distribution Data

Recording data for distributions is the main purpose of SELV. Each distribution is
divided into the facilities in its delivery zone. In the Record Data process, you will enter
data for each facility separately. As you record data, SELV will cache the data until you
fully synchronize the distribution with the server while in online mode. For more on
synchronizing a distribution, see page 33.

Record Data for Facilities

Step-by-step guide

1. If you are not already logged into SELV, follow the instructions on Accessing the
SELV Website (page 5).

2. Click Distributions > Manage to navigate to the initiated distributions page.

3. From the "Initiated Distributions" list at the bottom, select which distribution you
would like to enter data for.

4. Click Record Data. If there are no distributions in the list, follow the instructions on
Initiating Distributions (page 12).

Distribuigbes iniciadas
Zona de entrega Programa Periodo Estado

Norte Niassa Vacinas Margo-2013 INITIATED Registro de Dados Sincronize

Norte Niassa Vacinas Abril-2013 INITIATED Registro de Dados Sincronize

5. Choose a facility from the dropdown menu. Each facility has a color indicator
showing the status of its data completion within the system. For more information
on color status definitions, see Facility Completion Status Colors (page 17).
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o
E Sistema Eletrénico de Logistica de Vacinas Logado como FieldCoordinatorNiassal
Sair
Casa Distribuigbes portugués | English

Nenhuma instalagéo selecionado

® Nao iniciado Parcialmente concluido @ Concluido @ Sincronizado ® N&o é possivel sincronizar

X Zona de entrega : Norte Niassa Programa : Vacinas Periodo : Margo-2013

6. Use the tabs on the left to toggle between each of the seven categories for data
entry for the selected facility. For more information and explanations of the
reporting options for each category, see the guide sections on each tab.

(Tab 1 example)

Unidade Sanitaria : Ibo Sede, Ibo

® Nao iniciado Parcialmente concluido ® Concluido @ Sincronizado @ Ja foi sincronizado
Zona de entrega : Centro Cabo Delgado Programa : Vacinas Més : Maio-2014
® Informagéo da Informacao da Visita / Observagoes

Visita / Observagoes

Foi Ibo Sede, Ibo visitada em Maio-2014?
® Geleiras Sim Nao
® Inventario do PAV
® Uso do PAV

@ Criangas
Completamente
Vacinadas

® Cobertura de
Vacinagéo de
Criangas

® Cobertura de
Vacinagdo de Adultos
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[TAal £ AviarmAanla)
® Informagéo da Cobertura de Vacinagéo de Criangas Aplicar NR a todos os campos
Visita / Observagdes
0-11 meses 12-23 meses
® Geleiras Vacina de
Criangas Grupos Unidade Brigada Taxa de Unidade Brigada Total Frascos
L. (doses) Alvos Sanitaria Moével Total Cobertura Sanitaria Moével Total Vaginado abertos
@ Inventario do PAV
BCG 20 l ‘ ‘ 0 0% l ‘ ‘ ‘ 0 0 BCG
® Uso do PAV R R R R
NR
® Criangas
Completamente Polio 20 ‘ ‘ ‘ ‘ 0 0% 0 0
Vacinadas (Newborn)
NR NR
Polio10
® Cobertura de Polio 1st 20 | \ ‘ | 0 0% [ \ ‘ | 0 o |
Vacinagéo de dose
Criangas NR NR NR NR
Polio 2nd 20 [ ‘ ‘ ‘ 0 0% [ ‘ ‘ ‘ 0 o Polio20
® Cobertura de dose l
Vacinagéo de Adultos NR NR NR NR
NR
Polio 3rd 20 [ ‘ ‘ ‘ 0 0% [ ‘ ‘ ‘ 0 0
dose
NR NR NR NR

7. As you enter data it will be saved in the browser cache.
8. Continue on through the next section to learn about each tab and how to view
data completeness.

Tips and Tricks:
Why aren’t all the tabs displaying for each facility?

Are you offline? If the information showing on the tabs doesn’t match the screenshots,
there may have been a problem synchronizing the distribution correctly. If this occurs,
go online then return to the manage distribution screen and wait 5 minutes (the system
will be caching the application in the background). Try again. If you still are having
problems, contact your administrator.

Facilities Tabs
Facility Completion Status Colors

Each facility has color indicators that communicate that facility's data completion status.
These color indicators appear in two places on the SELV Record Data page:

1. The facility's overall data completeness appears as a colored dot next to the
facility name in the dropdown menu. (This menu is visible when you have
navigated through Distributions > Manage > Record Data for a specific initiated
distribution.)
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2. The completion status for each reporting category within a facility appears on that
category's tab once the facility has been selected. When a facility is selected
from the dropdown menu, each of its seven tabs on the left will show a colored
dot.

As noted in the color indicator key at the top of the page, these statuses are:

® Nao iniciado ) Parcialmente concluido @ Concluido @ Sincronizado @ ja Synched

Further explanation of status color:

Color Meaning Explanation
Red Not started No data has been entered for any part of the
category.
Partially completed Some data has been entered but there are one or

more parts that remain to be input.

Green Completed All data has been entered and the category is
complete but the data has not yet been synched with
the system.

Blue Synched All data for the category is complete and has been

fully synched with the system.

Gray Already Synched The data for this facility has already been synched
by another user. If you believe someone synced
your facility by mistake, contact the SELV admin.

Tab 1: Visit Info/Operations

Tab 1: Visit Info/Operations is where you record data on the date, vehicle, and
observations from the visit. This includes information from section 1 and section 8 on
the paper data collection form. Or, if the facility was not visited, it is where you record
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information on the reason for the no visit. The tab looks like this:

Informagéo da
Visita / Observagoes

® Geleiras

® Inventario do PAV

® Uso do PAV

® Criangas
Completamente
Vacinadas

® Cobertura de
Vacinagéo de
Criangas

® Cobertura de

Vacinagéo de Adultos

Informagao da Visita / Observagoes

Foi Ibo Sede, Ibo visitada em Maio-2014?

® Sim Nao

Data da Visita

Identificagdo do veiculo

Observagoes

Verificado por

Nome

Confirmado por

Nome

|

l | l

Titulo

Titulo

STARTING AT THE LAST MILE...

Was the facility visited in the given month?

The first question that you must answer in the Visit Info/Operations is if you visited that
health unit during the given month. If you select Yes, you will be asked to record visit

information and will able to input data for all tab categories. If you select No, you will be
asked to provide the appropriate reason and will be able to input data for only tabs 5, 6,

and 7.

Yes, the facility was visited during the given month:
Click Yes and proceed with recording the data from your visit in all tabs.

No, the facility was not visited during the given month:
Click No and be sure to note the appropriate reason. See the explanation of reasons

below to help you choose the best answer:
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Reason

Road impassible or bad
weather

STARTING AT THE LAST MILE...
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Explanation of Reason

While on the distribution you were unable to make it to this particular
facility because the road was impassible.

Transport not available

The car was not functioning or was being used for other purposes.

The health center was
closed

You drove to the health center, but no one was there to receive the
goods.

Per diem funds not available

The entire distribution was cancelled because per diem funds were
unavailable.

Fuel funds not available

The entire distribution was cancelled because fuel funds were
unavailable.

The health center is not part
of DLS program

This facility is not currently included in the DLS program.

Other

The most appropriate reason was not listed above. Please type your
reason in the text box provided.

Tips and Tricks:

® The vehicle data in Tab 1: Visit Info/Operations is optional.

* If you select "No" for the first question on Tab 1: Visit Info/Operations, all fields for tabs 2, 3, and
4 will be automatically recorded as "NR" (No Record). These fields will be locked out and you will
not be able to type in any data. This is because if you did not visit a facility, you will have no
information for those fields.

SELV User Manual — VillageReach, June 2014 20




VILIAGE}SF(ACH®

STARTING AT THE LAST MILE...

Tab 2: Refrigerators

Tab 2: Refrigerators is where you record information on the status of the refrigerator at
each facility. You must first add the refrigerators to the system and then you will be able
to record data on them. Before any refrigerators have been added, the tab will look like
this:

omassoda  Geleiras [ aioear i |

Visita / Observagoes

Nao foram adicionadas geleiras
® Geleiras
® Inventario do PAV

® Uso do PAV

@ Criangas
Completamente
Vacinadas

® Cobertura de
Vacinagéo de
Criangas

® Cobertura de
Vacinagdo de Adultos

Recording Refrigerator Data
1. Find the refrigerator in the list. (Usually there will be only one listed.)
2. Click Show.

3. Enter the refrigerator data from the visit. If you do not have any information on
high or low alarm events, select NR for those fields.
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Marca Tipo Modelo

° Sibir V110KE Gas @

Qual era a temperatura da geleira quando vocé chegou?

°C NR

Houve um problema com a geladeira desde a ultima visita?

Sim Néo Néo sei NR

Numero de eventos de alarmes altos desde a ultima visita

NR

Numero de eventos de alarmes baixos desde a Gltima visita

NR

Est funci 1do corret; 1te quando vocé saiu? (2-8°C)

Sim Néo Néo sei NR

Notas

4. When complete, click Done.

Adding a New Refrigerator

When do | add a refrigerator?

You do not need to add the refrigerator every month. The refrigerator only needs to be
added once. You will only need to add a new refrigerator if a new refrigerator is
provided to the facility.

The information that you will need to add a new refrigerator is its:

1. Brand (for example, Sibir)
2. Type (for example, Gas)
3. Model (for example, V110KE)
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Step-by-step guide: Add a New Refrigerator

1. From the Refrigerators tab, click Add New. If you are unsure how to get to this
point within recording data for a facility, see Recording Distribution Data (page
15).

N&o foram adicionadas geleiras

2. Enter the refrigerator’s brand, type, and model in the spaces provided.

Nova Geleira

Marca*

Tipo

Modelo

3. Click Done.
4. The refrigerator will now appear in the list within the refrigerator tab category. If
you made a mistake with the brand/model/type information, click Delete and try

again.
Geleiras
Marca Tipo Modelo
® Sibir V110KE Gas [ Excluir |

5. To record data for a refrigerator, click Show.
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Marca / Modelo N° Serie

Sibir V110KE

Qual era a temperatura da geleira quando vocé chegou?

°C NR
Houve um probl com a geladeira desde a tltima visita?
Sim ® Nio N&o sei NR

Numero de eventos de alarmes altos desde a tltima visita

NR

Numero de eventos de alarmes baixos desde a ultima visita

NR

VILLAGE}SE(ACH®

STARTING AT THE LAST MILE...

Fonte

Estava funci do corret te quando vocé saiu? (2-8°C)

Néo sei NR

Sim ® Nao

Quais sdo os problemas?
Erro no Operador
Elétrico / Gas / Gasolina
Problema com Queimador
Termostato
Vazamento de gas ou problema na linha de gas

Outro

Notas

6. Record the data and click Done when finished.
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Tab 3: EPI Inventory: Delivery & Stock Information is where you record data on the
existing, delivered, and spoiled quantities of the EPI's for the selected facility. It looks

like this:

® Informaggo da
Visita / Observagdes

Geleiras
@ Inventario do PAV
® Uso do PAV

@ Criangas
Completamente
Vacinadas

® Cobertura de
Vacinaggo de
Criangas

@ Cobertura de

Vacinagéo de Adultos

Inventario do PAV: Informagéao de Entrega e Stock

(Frascos/unidades)

BCG

Polio (10 dose)

Polio (20 dose)

Pentavalent (1 dose)

Pentavalent (10 dose)

PCV10

HPV

Sarampo

VAT

Seringa 5ml

Seringa 0,5mi

Seringa 0,05ml

Caixas Inciner.

Gés (Cilindro)

Stock Ideal

Distribuido

Estragadas

Aplicar NR a todos 0s campos

NR

NR

NR

NR

NR

NR

NR

NR

NR

NR

NR

NR

NR

NR

NR

NR

NR

NR

NR

169 ‘

NR

NR

NR

NR

NR

NR

NR

NR

Tips and Tricks:

There is an important difference between quantity: 0 and NR. If a health center's EPI inventory
has completely run out (stockout), then the correct input is 0. If a health center's EPI inventory is
unknown, the correct input is NR (no record). For more on how to use the NR checkboxes, see

Understanding and Using NR (page 30).

If the quantity delivered plus the existing quantity is greater than or equal to the ideal quantity,
you have made a Full Delivery. The percentage of full deliveries is included in reports sent to
managers. To ensure you make full deliveries, review the Prepare the Distribution report prior to

leaving on your trip.

Check that the Ideal Quantity values for the health center make sense. If not, contact the system
administrator with the suggested Ideal Quantity and the system amount can be overridden. This

is essential for ensuring you get credit for full deliveries.
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* Note that you can’t NR the Delivered Quantity fields. Enter a value of 0 if you did not deliver any
of that product.

Tab 4: EPI Use

Tab 4: EPI Use / EPI Stock Information is where you record data on the received, distributed,
and lost vaccines for the selected facility. It looks like this:

@ Informaggo da Informagédo Sobre o Movimento de Vacinas Aplicar NR a todos os campos
Visita / Observagoes

Stock ao Inicio do Stock ao Fim do

Geleiras Stock do PAV (doses) Més. Recibidas Total Distribuidas Perdas Més Data de Expiragdo (MM / AAAA)
@ Inventério do PAV BeG l l l l 0 l l [ ‘ l l l l
NR NR NR NR NR NR
Uso do PAV
o eV [ J | ° | J | | | | I
® Criangas NR NR NR NR NR NR
Completameme PCV10 l ‘ l l 0 l l [ ‘ l l l ‘
Vacinadas
NR NR NR NR NR NR
Vacnagode. Pertavalent [ | l ol J | ) | | l
Criangas NR NR NR NR NR NR
® Cobertura de Poll ‘ ‘ [ ‘ 0 [ ‘ [ ‘ ‘ ‘ [ ‘
Vacinagéo de Adultos NR NR NR NR NR NR
seramee l | l ol | ) | | l
NR NR NR NR NR NR
VAT | | | ° | | | | | | | \
NR NR NR NR NR NR

Tips and Tricks:

There is an important difference between quantity: 0 and NR. If you are unable to collect EPI
Use information, select NR. However if the quantity of any value is actually zero, enter 0. For
more on how to use the NR checkboxes, see Understanding and Using NR (page 30).
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Tab 5: Full Coverage

Tab 5: Full Coverage is where you record data on the number of completely vaccinated male
and female children. It looks like this:

@ Informaggo da Informagéo Sobre o Movimento de Vacinas Aplicar NR a todos os campos
Visita / Observagoes
Stock ao Inicio do Stock ao Fim do
Geleiras Stock do PAV (doses) Més Recibidas Total Distribuidas Perdas Més Data de Expiragédo (MM / AAAA)
@ Inventério do PAV Bee ‘ ‘ l ‘ 0 l ‘ l ‘ ‘ ‘ l ‘
NR NR NR NR NR NR
o e e [ J J ° | J | | | | l
® Criangas NR NR NR NR ' NR NR
Vocnacn pevio { J | l ° | J | | | ) I
NR NR NR NR NR NR
o pentavaen [ J J ol J M | l
Criangas NR NR NR NR NR NR
@ Cobertura de Poto [ l l ] 0 l l l ‘ [ l l l
Vacinagéo de Adultos NR NR NR NR NR NR
seramee l | l ° | | M | | \
NR NR NR NR NR NR
v [ J l ° J | | | l
NR NR NR NR NR NR

Tips and Tricks:

There is an important difference between quantity: 0 and NR. If a health center's number of full
coverage vaccinations is 0, then the correct input is 0. If a health center's number of full
coverage vaccinations is unknown, the correct input is NR (no record). For more on how to use
the NR checkboxes, see Understanding and Using NR (page 30).
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Tab 6: Child Coverage

Tab 6: Child Coverage is where you record data on the target group and coverage rate for
different EPI child vaccinations. It looks like this:

® Informagzo da Cobertura de Vacinagao de Criangas Aplicar NR a todos os campos
Visita / Observagdes
0-11 meses 12-23 meses
Geleiras Vacina de Criangas Frascos Abertos -
(doses) Grupos Alvos Unidade Sanitéria Brigada Mével Taxa de Cobertura Unidade Sanitaria Brigada Mével Total Total Vaginado Frascos abertos  Taxa de Desperdicio

g

@ Inventario do PAV = s ‘ﬁ ﬁ o 0% [—‘ [—I o o | Bea
@ Uso do PAV NR NR NR R [—
NR
® Criangas Polio (Newborn) 7 0 0% 0 0
Completamente LJ
Vacinadas NR NR Polio10
Polio 1st dose 7 :] 0 0% :] 0 0
@ Cobertura de | ‘ {—
Vacinagao de NR NR NR NR
Criangas
Polio 2nd dose 7 0 0% 0 o Polio2o
o Cobertura ce W o " m ]
Vacinag&o de Adultos NR
Polio 3rd dose 7 ‘ ‘ 0 0% ‘ 0 0
NR NR NR NR
Penta 1st dose 7 ‘ ‘ ‘ 0 0% ‘ ‘ 0 0
Penta1
NR NR NR NR
Penta 2nd dose 7 ‘ 0 0% ‘ 0 0
NR NR NR NR fentato
Penta 3rd dose 7 0 0% 0 0
NR
NR NR NR NR
PCV10 1st dose 7 0 0% 0 0
NR NR NR NR
PCV
PCV10 2nd dose 7 0 0% | 0 0 —
NR NR NR NR NR
PCV10 3rd dose 7 ‘ ‘ 0 0% ‘ ‘ 0 0
NR NR NR NR
Measl: 7 0 0% 0 0 Measles
C 1 C C 1 CJ =
NR NR NR NR

Tips and Tricks:

* There is an important difference between quantity: 0 and NR. If a health center's number
of vaccinations for a specific vaccine/dose is 0, then the correct input is 0. If a health
center's number of vaccinations for a specific vaccine/dose is unknown, the correct input
is NR (no record). If the number of doses administered is N/R, no child coverage rate for
the vaccine/dose will be calculated, where as if doses administered is 0, the child
coverage rate will be 0%. For more on how to use the NR checkboxes, see
Understanding and Using NR (page 30).

* If you are having trouble scrolling left to right to see all of the data fields, you can use the
zoom tool in Firefox to zoom out and see all fields at once. In the Firefox menu toolbar,
go to View > Zoom and make sure that Zoom Text Only does not have a checkmark by
it. If it does, click it to uncheck. You can now use the Zoom In and Zoom Out options on
the menu to see all fields in the tab.
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Tab 7: Adult Coverage

Tab 7: Adult Coverage is where you record data on the tetanus EPI's administered to adults.

Adults in this category are divided into the categories of pregnant women, community, students,

workers, and other. The tab looks like this:

® Informagéo da
Visita / Observagdes

Geleiras

@ Inventario do PAV

@ Uso do PAV

@ Cobertura de
Vacinagéo de
Criangas

® Cobertura de
Vacinagéo de Adultos

Cobertura de Vacinagao de Criangas

Vacina de Criangas
(doses) Grupos Alvos

BCG 8

NR

Polio (Newborn) 7 ‘

Polio 1st dose 7 ‘

Polio 2nd dose 7 ‘

Polio 3rd dose 7 ‘

Penta 1st dose 7 ‘

Penta 2nd dose 7 ‘

Penta 3rd dose 7 ‘

PCV10 1st dose 7 ‘

PCV10 2nd dose 7 ‘

Unidade Sanitéria

0-11 meses

Brigada Mével

Total

Taxa de Cobertura

Unidade Sanitaria

Total Vaginado

Aplicar NR a todos os campos

Frascos Abertos -
Frascos abertos  Taxa de Desperdicio

Penta10

NR

PCV

PCV10 3rd dose 7 ‘ ‘ ‘ 0 0% ‘ ‘

°
°

Measles 7

NR

Tips and Tricks:

* There is an important difference between quantity: 0 and NR. If a health center's number
of vaccinations for a specific group is 0, then the correct input is 0. If a health center's
number of vaccinations for a specific group is unknown, the correct input is NR (no
record). ). If the number of doses administered is N/R, no child coverage rate for the
vaccine/dose will be calculated, where as if doses administered is 0, the child coverage
rate will be 0%. For more on how to use the NR checkboxes, see Understanding and
Using NR (page 30).

* If you are having trouble scrolling left to right to see all of the data fields, you can use the
zoom tool in Firefox to zoom out and see all fields at once. In the Firefox menu toolbar,
go to View > Zoom and make sure that Zoom Text Only does not have a checkmark by
it. If it does, click it to uncheck. You can now use the Zoom In and Zoom Out options on
the menu to see all fields in the tab.
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Understanding and Using NR

When filling in the data for tabs 3, 4, 5, 6, and 7 on the Record Data page, you will see
an option to select a box for "NR." NR stands for "no record," and it means that you do
not have any information on the quantity of vaccines for that piece of data. The most
important thing to remember in understanding this is that NR does NOT mean the same
thing as quantity 0. NR simply means that there is no data. (For example, if the vaccine
doses are not accessible to be counted.)

How do | use the NR box when recording data?

If you need to record NR as the input for multiple data entries within a tab, you can use
the Apply NR to all fields button in the top-right corner of the tab. This will check ALL
NR boxes within the tab.

Step-by-step guide: Apply NR to All Fields

1. Start from the Record Data page with the chosen facility selected from the drop-
down menu. For more on accessing and using the Record Data page, see

Recording Distribution Data (page 15).
2. Select the tab category that you would like to record data for.

Inventario do PAV: Informagao de Entrega e Stock Aplicar NR a todos os campos
(Frascos/unidades) Stock Ideal Existente Distribuido Estragadas
Bee 5 | || |
NR NR
Polio (10 dose) 5 ‘ ‘ ‘ ‘ | ‘
NR NR
Polio (20 dose) 3 ‘ ‘ ‘ ‘ | ‘
NR NR
Pentavalent (1 dose) 31 ‘ ‘ ‘ ‘ ’ ‘
NR NR

3. If you are ready to apply NR to all fields, click the Apply NR to all fields button in
the top right-hand corner of the tab. Note: Clicking this button will automatically
clear any numbers you have already input on that tab for data where NR is an
option. You will see an alert box before confirming your choice.

Aplicar NR a todos os campos
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Aplicar NR a todos os campos

Esta agao ira limpar todos os dados no formulario e definir cada campo por NR,
deseja continuar?

mi_l -

4. Click OK.
5. You will now see the NR box checked for all fields.

Inventario do PAV: Infonnagéo de Entrega e Stock Aplicar NR a todos os campos
(Frascos/unidades) Stock Ideal Existente Distribuido Estragadas
BCG 5 { ]
¥ NR ¥ NR
Polio (10 dose) 5 { ]
¥ NR ¥ NR
Polio (20 dose) 3 ‘ ‘
¥ NR ¥ NR
Pentavalent (1 dose) 31 { \
¥ NR ¥ NR

6. If you have number data to enter in any of the fields, uncheck the NR box below
the field and type in the data.

7. Once you have completed all tabs for a facility, see Synchronizing a Facility
(page 33).

Tips and Tricks:

If you need to input both NR and number data within a tab, make sure that you record the NR's
first. That way you will avoid accidentally clearing numbers you have already typed in. If you
want to use the Apply NR to all fields button, make sure you use it before typing in any
number data for the tab.
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Special Cases for Missing Data

When entering data for a distribution, you must enter data for every single facility in the
delivery zone. The distribution upload is not complete until an entry is made for every
facility, including facilities that you did not visit. Steps for entering data when you visited
a facility were included in the previous section. This section includes what to enter when
you did not visit a facility.

Entering Routine Data from Forms

If you didn’t visit the health unit but were able to collect the paper Child Coverage and
Adult Coverage forms from the district office, you can still record data for that facility.

Important steps:

1. On Tab 1: Visit Info / Operations, indicate that you did not visit the facility and
indicate the reason.

2. Enter the routine data from the forms in Tab 5: Full Coverage, Tab 6: Child
Coverage, and Tab 7: Adult Coverage.

3. For Tab 3: EPI Inventory, choose NR when available and enter O for delivered
quantities.

4. For all other tabs select NR for the data fields.

5. The facility status color in the drop-down should now be green. The facility is
ready to be synched.

Unable to Collect Routine Data

If you did not visit the health unit and you also did not get the routine data forms from
the district office, there are other steps you take to record data.

Important steps:

1. On Tab 1: Visit Info / Operations, indicate that you did not visit the facility and
indicate the reason. Do NOT select “Not in DLS Program,” as there is a different
process for that reason.

2. For Tab 5: Full Coverage, Tab 6: Child Coverage, and Tab 7: Adult Coverage,
click Apply NR to all fields.

3. The facility status color in the drop-down should now be green. The facility is
ready to be synched.

Facilities Not Served by the DLS Program

All health centers in each province are listed in SELV, even if they are not served by the
DLS. If a decision has been made by the province note to include the facility in the DLS:

Important steps:
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1. On Tab 1: Visit Info / Operations, indicate that you did not visit the facility and
indicate “Not in DLS Program” as the reason.

2. For Tab 5: Full Coverage, Tab 6: Child Coverage, and Tab 7: Adult Coverage,
click Apply NR to all fields.

3. The facility status color in the drop-down should now be green. The facility is
ready to be synched.

Missed Distributions

Even if you have completely missed a distribution, it’s still important to record
the reason why it was missed. In addition, since you will have no number data for the
facilities, you should indicate NR for all relevant fields. This should be done for each
facility in the distribution.

Important steps:
1. On Tab 1: Visit Info / Operations, indicate that you did not visit the facility and

select the reason.

2. For Tab 5: Full Coverage, Tab 6: Child Coverage, and Tab 7: Adult Coverage,
click Apply NR to all fields.

3. The facility status color in the drop-down should now be green. The facility is
ready to be synched.

Synchronize the Distribution

Synchronizing the distribution is the last step in the SELV recording data process. You
will be able to synchronize a distribution only after all data entry for facilities in that
distribution is complete. Once a distribution is fully synchronized, you cannot go back
and view or change any of the recorded data.

Synchronizing a Facility

At the end of every data entry session, synchronize your data. This will ensure that
you don’t have to re-enter data if something happens to your computer. When you
synchronize, all facilities that are complete (status color green in the drop-down menu)
will be uploaded and then their data cannot be changed. Make sure that all tabs the
facilities in the drop-down menu on the Record Data page that you want to sync have
green status color dots. If they do not, they will not sync.
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Step-by-step guide:

1. Connect your computer to the Internet.

2. Go to Distribution > Manage in SELV.

3. Click the Go Online button. (If you are already in online mode you will not see
this button. Continue to Step 4.)

4. Click the Sync button next to the distribution you have been entering data for.

5. Wait for the message that the distribution has been synchronized.

6. Whenever you are ready, you can continue entering more data for the
distribution. Synchronize again when you are complete.

Tips and Tricks:

* If the distribution you are attempting to synch is not complete, you will get an alert
saying "No facility for the chosen zone, program and month is ready to be synched."

Nao ha Nenhuma unidade sanitaria para a zona escolhida, o programa e periodo estdo prontos para ser sincronizados

This means that there are still incomplete data fields in at least one of the facilities within
the distribution you are trying to synch. Click Record Data for the chosen distribution in
the list and look at the status colors in the facility dropdown menu to determine where
you are missing data. Once a facility's data is complete you can attempt to synch

again. See Facility Completion Status Colors (page 17) for more information on status
colors and data completion.

* If you synchronize a facility or distribution and then realize that you have made some
errors in recording the data, contact the SELV admin for assistance. They can correct
the error.

Completing Monthly Data Entry (Finalizing Synchronization)

Each distribution is made up of all the facilities in its zone. When a facility is complete
and you push the “Sync” button on the Distributions > Manage page, that facility is
synchronized with the server. A distribution is not fully synchronized until ALL its
facilities have been synchronized. To see which facilities for a distribution have been
synchronized and which ones remain:

Step-by-step guide:

1. Go to the “Initiated Distributions” list. (Under Distributions > Manage)

SELV User Manual — VillageReach, June 2014 34




VILIAGERF(Acm

STARTING AT THE LAST MILE...

2. Click Record Data for the selected distribution.

3. Use the drop-down menu to scroll through the facilities and see which ones have
a blue status color dot. Ones that do not have a blue dot are incomplete and
have not been synchronized. For more on the facility status colors, see Facility
Completion Status Colors.

4. Finish entering the data for all fields in each facility. When a facility has a green
status color dot, it is ready to be synchronized.

5. Check that the Status of the Distribution is “Synced.”

6. If you no longer want to store the distribution, you may now delete it from your
cache.
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Before heading out on a delivery, you will want to know what quantity of EPI vaccines is
needed for each health center. The View Load Amounts feature in SELV provides you
with this information so that you can have the right supplies for each trip. Viewing load
amounts can only be done while in online mode. For more information on SELV

functionalities in online mode, see Online and Offline Functionalities.

Step-by-step guide: View Load Amounts

1.

w

6.

Make sure you are in online mode. For how to switch to online mode, see Go Into
Online Mode (page 10).
Go to Distribute > Manage.
Select the Zone, Program, and Month that you would like the information for.
Click View Load Amounts

Ver valores de carga

A new page will open where you will see the total supply amounts needed for the
district selected, followed by the individual amounts needed for each facility.

Quantidade de carga Armazém

Zona de entrega : Norte Niassa

Norte Niassa Total

BCG

Distrito Populagio  BCG

Lago 80639

Lichinga Cidade 144715
Lichinga Distrito 96800
Majune 22861
Mandimba 109307
Mavago 20308
Muembe 20632
N Gauma 46188
Sanga 61387

390

270

450

240

240

120

150

210

330

Zona total 602837 2400

PCV10

PCV10

547

976

655

158

736

138

141

313

418

4082

Programa : Vacinas

Pentavalent

Pentavalent (1 dose)

1235

2210

1482

353

1670

311

317

706

940

9224

Polio

Periodo : Margo-2014

Sarampo

Pentavalent (10 dose)  Polio (10 dose)  Polio (20 dose) ~ Sarampo

123

222

148

35

168

32

32

69

94

923

165

295

199

48

222

42

42

94

125

1232

83

148

100

23

112

20

21

48

62

617

48

85

59

VAT

VAT

93

168

110

27

126

23

25

53

72

697

Seringa 5ml Seringa 0,5ml

0
0
0
0
0
0
0
0
0
0

24151

43335

28990

6849

32732

6082

6181

13833

18386

180539

Seringa 0,05m!

453

806

546

130

610

115

116

260

346

3382

Caixas Inciner.  Gas (Cilindro)

(Optional) If you want to print this View Load Amount data sheet, go to File >
Print Preview. Select 90% in the Scale dropdown menu (this will ensure all

columns appear on the sheet) and select Landscape for page style. When
finished, click Print.

l[ Print... ] [PageSetgp...' Page: 4 «

1 of 4 P P

e [ st | o= )

SELV User Manual — VillageReach, June 2014

36



STARTING AT THE LAST MILE...

VILIAGE}SF(ACH®

Deleting a Distribution

Once you have synchronized all of the facility information for a distribution, you may
choose to delete it from the initiated distributions list. This is an optional step.
Alternatively, if you have made a mistake in initiating your distribution (for example, you
selected the wrong month), you may wish to delete the distribution as well.

Step-by-step guide: Delete a Distribution

1. Go to Distributions > Manage.
2. Find the distribution that you wish to delete from the "Initiated Distributions" list.
3. Click the red and white X icon.

O

4. If you are sure you want to delete this distribution, click OK in the alert box.
Apagar distribuicao

Tem certeza que deseja apagar esta distribuicao? Qualquer dado que nao tenha
sido sincronizado com o servidor sera perdido.

5. Once deleted, the distribution will not longer appear in the "Initiated Distributions"
list.

Log Out

You will want to log out if you need to switch credentials or if another user needs to log
in. You can only log out of SELV while in online mode. For how to switch to online
mode, see Go Into Online Mode (page 10).

Step-by-step guide: Logging Out

Note: Once you log out, you will not be able to access SELV in offline mode.

1. Make sure you are in online mode. (See Go Into Online Mode, page 10).
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2. Click Logout (Sair) In the upper right-hand corner of the page.

Logado como FieldCoordinatorNiassa | Sair

3. You are now logged out. To log back in, see Accessing SELV in Online Mode
(page 35).

SELV User Manual — VillageReach, June 2014 38



Appendix

VILIAGE

FACH.

STARTING AT THE LAST MILE...

Paper form for Health Unit monthly data collection, page 1:

Dados Mensais da Unidade Sanitaria
Monthly Health Center Data

@ Informacao da Visita/Visit Information

Distrito: District

0 Sim, eu visitei

Unidade Sanitaria:
Health Unite

Data de visita: (oo/rewy
ARAA) Date of Visit

S S (I

Data dos Dados Mensais:

=

Se a US ndo foi visitada,
avance para a secgio 4.

(1) A U.S. foi visitada?

0O Nao, ninguém visitou

Se "N3o" para (1), re

sponder a (2)

{2)Qual a razdo de ninguém ter visitado?

O Nao se podia p.

O Outros

O A U.S. estava fechada na altura da visita

assar na estrada de acesso ou mau tempo.

O Transporte nao disponivel

O Per diem ou combustivel n3o disponivel
O O centro de saude nao faz parte do SDL

@ Informacdo da Geleira/Fridge Info
1D:

{1) Qual a temperatura da
geleira quando chegou
als?

Temp.:

{2) Tem havido problemas
com a geleira desde

a dltima visita?

0 Sim

0 Nie

0 Nio sei

@) Quando saiu da US, a geleira estava a\
funcionar correctamente (temperatura
entre 2-8 °C)?

0 Sim
0 Nio
O Nio sei

Se "Nao” para (3), responder a (4)

(4)Quazl é o problemal(s)?

(]Erro do Operador [ Cutros

S| Problema com

“ gueimador

.., Vazamento de gds cu
problem com rede de gis

.. Falta de electriodade/gas/
petral

\ CJAjuste do Termastato

1D:

(1) Qual a temperatura da
geleira quando chegou
aus?

Temp.: ‘¢

Tem havido problemas
com a geleira desde
a ultima visita?

(2)

O Sim
O Nae
O Nao sei

GJ Quando saiu da US, a geleira estava a\
funcionar correctamente (temperatura

entre 2-8 °C)?
0 Sim
0 Nio
0 Nio sei

Se "N&o" para (3), responder a (4)

(8)Qual é o problema(s)?

'_IErro do Operador (] Qutros

._]Problema com
gueimador

.., Vazamento de gis cu
problem com rede de gas

- Falta de electriodade/gas/
petral

\ CAjuste do Termastato

@ Inventério do PAV: Informacdo de Entrega e Stock/EPI Inventory: Delivery & Stock Information

Nota: Margue ndo registados (NR) se © numero ndio estiver disponivel; Se ndo houver nenhum, registre um “0". / Note: Mark not registered NR if the number is not
ovoilable; if there is none, register “0%

(frascos/unidades) | Stock ideal Existente Distribuido Estragadas frascos/unidades | tock Ideal Existente Distribuido
Vials/units |deal stock Existent Distributed Ruined
“-..\. Seringa Smil, NR
BCG, T o NR NR e
J s Seringa 0,5ml_ eslonR
VAP (10 dose o o NR NR S
| T Seringa 0,05ml, s lonR
VAP (20 dose) B =1 NR A_‘_T-\_\
~~~~~~ Caixas Inciner. o T
Pentavalent (1 dose) e o KR NE I~
- . .
A Gés (Cilindro e MR
| Pentavalent (10 dose) s N MR L g
] uJ I 111 NE
| VA{\ B 1T lang
le o 1 11 NR
@ Informa‘gio Sobre o Movimento de Vacinas / Informatign on V¥Ci"e movemognt Resumo mensal do PAV —
Noto: Margué nde registados (NR) se o ndo estiver disp I, Se ndo houver nenhum, registre um "0, (some i |
o5 above) Crian¢as Completamente
Stockoo Vacinadas / Monthly EPI
Inicio do Ms Stock 30 Fim summary — completely vaccinated
Stock at doMés | Data de Expiracdo E children
g Stock do PAV | beginning of | Recebidas Distribuidas | Perdas |Stockatend | Expiration Date <
doses, month Received Total Distributed Lost of menth (MM / AARA) E Brigada
E ey % Criancas Unidade Mével
P BCG|o NR o NR B 111} o NR o NR ane  f Compl Sanitaria Mobile
§ e § Vacinadas (doses) | Health Unit| Brigades
= Polio] o NR. L Bt 1171 SR aNR e >
Pentavalent o NR o NR e fone |onr S NR ok f S
SR =y I
Sarampo o NR. o NR B 1 11 [oNR aNR ake_ |/ o NR
"""""" i
PCV 10, LN . o ung [oNR INR ake [
Ry |
VAT NR o NR "o o KR SINR o NR ONR_/
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FACH.
Paper form for Health Unit monthly data collection, page 2:

STARTING AT THE LAST MILE
- - - ” -
Dados Mensais da Unidade Sanitaria / Monthly Health Center Data
@ Resumo mensal do PAV da Unidade Sanitéria - BCG, DPT-HepB-Hib Polio, PCV10 e Sarampo
Monthly Health Center EPI summary — BCG, DPT-HepB-Hib, Polio, PCV10 and Sarampo
Noto: Margue ndio registados (NR) se o numero ndie estiver disponivel; Se ndo houver nenhum, registre um “0". Note: Mark not registered NR if the number is not availoble; if
there is none, register “0*.
Vacina de Criangas 0-11 Méses / 0-11 months 12-23 Méses / 12-23 months Frascos Abertos|
(doses) Unidade Brigada Taxa de Unidade Brigada Total - Taxa de
é IChild Vaccines Grupe Sanitaria Movel Cobertura | Sanitaria Mével Vaginado Frascos desperdicio
< |(doses) Alvos Health Mobile Coverage Health Mobile Total Abertos | Open Vials—
E _T:rgel group|  Center Brigades e Total - rate Center Brigades - Total _‘.\‘Iaccmated Open Vials by.v‘aslage Rates
5 BCG e, B i - S - Ry
T~ NR NR b “wJdaNR o NR e Lo KR -~
8 — R .. \
» Polio (primario) R e . :
g T lone JNR . p G 10-dose \‘\
Polio 12 dose{ = g g SRR i [ h
< ~eol 0 NR NR < - = aNR o NR e~ - — | \‘\
Polio 2° dosef A T oo ) b 208 T \
x e long NR e e one o NR B s S [i20 doss \,
P "-\ \'\, "*._ "‘._ \‘
Polio 3 dosel  w_ e e G S 2 I b
. ~~ o R NE . . : ~JaNR LR . . ) . | RE \
Penta 1 dose] . P NY G . Sowz .
g o NR oNR I T o NR o KR o~ S| 1-dose .
S~ o~ g S oy I \,
Penta 27 dosef P S . .. S \\
a2 Saol o NR INR - . \ e o NR o KR = N *e 10-doce \
Ras. 04 e b U8 e b W \
Penta 37 dose| Ty b O b . (o, \\
- sl NR INR Le R S~ JaNR o NR e '7\" B LS - -
e sl ~ S, e, e
PCV10 1] dose| S . S = NS T
e el oNR INR e ‘\._\ ~dNR o NR - ‘-..\ and - ~aad
PCV10 2* dose| "\\ Y T L e R
- “sob i NR INR b "\_\ T aNR o NR - -t g - Sl
PCV1O 3 dose] e R .. h O S i
B ~o o R CONR e ~ o NR o KR - S s
A e e Tl T e,
Sarampoy " M i I T R,
~~ o NR NR . o 1T N8 T RIS ] -
@ Resumo mensal do PAV da Unidade Sanitaria - VAT / Monthly health center EPl summary — VAT
Nota: Marque ndo registodos (NR) se o numero ndo estiver disponivel; Se ndo houver nenhum, registre um “0°.
VAT 17 dose VAT 29-52 dose iy
rupos de Vacinagdo S
E 4 ) Taxa de
(=3 Y. d grouns Grupo Brigada Brigada Total Taxa de desperdicio
§ i group Alvos Unidade Movel Unidade Movel Tétano | Cobertura Frascos | Open Vials -
& Target Sanitdria Mabile Sanitéria Mabile Tetanus | Coverage | Abertos Wastage
6 L Group _ |Health Center Brigades . Total Health Center Brigades L TJotal | Total .. rate Open Vials Rates
5 Mulheres Gravidas . : "‘-.\ \\.‘ .\.\ \‘~.\ i
. Pregnant Women I S NR I S NR S R s 1\
Comunidade S G Y \
Community) MR o NR ok oS NR B i \
S < S \
MIF Estudante. S S e \
152 Student 2N B SNR R o i
49 rabalhad S S ~— A
anos | '@ av‘fo(:r:': S N ™ i
SubTotal e e . Zaa B, O — Sy el T \
- - - - - .~ ~, \
Estudantes ndo MIF " RS R e e \
Students not MIF S S NR B, o NR it T . i
Trabalhadores ndoMIF s N . M S kY
Waorkers not MIF . N hea S NR . e e 4
Outros ndo MIF, b o T . i
IF e ; .. . \
Others not MIF -.’f'_* N8 - E{! a8 - - . — ‘.‘.
Total s S g ) 0 e e T ~— S o na Y
(s) Observacées da Visita: / Observations from the Visit
Verificado por: _verified by

Fungdo: Function

Confirmado por: Confirmed by

Fungdo: Function
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